
Chipsmall Limited consists of a professional team with an average of over 10 year of expertise in the distribution

of electronic components. Based in Hongkong, we have already established firm and mutual-benefit business

relationships with customers from,Europe,America and south Asia,supplying obsolete and hard-to-find components

to meet their specific needs.

With the principle of “Quality Parts,Customers Priority,Honest Operation,and Considerate Service”,our business

mainly focus on the distribution of electronic components. Line cards we deal with include

Microchip,ALPS,ROHM,Xilinx,Pulse,ON,Everlight and Freescale. Main products comprise

IC,Modules,Potentiometer,IC Socket,Relay,Connector.Our parts cover such applications as commercial,industrial,

and automotives areas.

We are looking forward to setting up business relationship with you and hope to provide you with the best service

and solution. Let us make a better world for our industry!

Contact us
Tel: +86-755-8981 8866 Fax: +86-755-8427 6832

Email & Skype: info@chipsmall.com Web: www.chipsmall.com

Address: A1208, Overseas Decoration Building, #122 Zhenhua RD., Futian, Shenzhen, China

    



© 2005 Microchip Technology Inc.   DS51589A

Explorer 16 Development Board

User’s Guide



DS51589A-page ii © 2005 Microchip Technology Inc.

Information contained in this publication regarding device

applications and the like is provided only for your convenience

and may be superseded by updates. It is your responsibility to

ensure that your application meets with your specifications.

MICROCHIP MAKES NO REPRESENTATIONS OR WAR-

RANTIES OF ANY KIND WHETHER EXPRESS OR IMPLIED,

WRITTEN OR ORAL, STATUTORY OR OTHERWISE,

RELATED TO THE INFORMATION, INCLUDING BUT NOT

LIMITED TO ITS CONDITION, QUALITY, PERFORMANCE,

MERCHANTABILITY OR FITNESS FOR PURPOSE.

Microchip disclaims all liability arising from this information and

its use. Use of Microchip’s products as critical components in

life support systems is not authorized except with express

written approval by Microchip. No licenses are conveyed,

implicitly or otherwise, under any Microchip intellectual property

rights.

Trademarks

The Microchip name and logo, the Microchip logo, Accuron, 

dsPIC, KEELOQ, microID, MPLAB, PIC, PICmicro, PICSTART, 

PRO MATE, PowerSmart, rfPIC, and SmartShunt are 

registered trademarks of Microchip Technology Incorporated 

in the U.S.A. and other countries.

AmpLab, FilterLab, Migratable Memory, MXDEV, MXLAB, 

PICMASTER, SEEVAL, SmartSensor and The Embedded 

Control Solutions Company are registered trademarks of 

Microchip Technology Incorporated in the U.S.A.

Analog-for-the-Digital Age, Application Maestro, dsPICDEM, 

dsPICDEM.net, dsPICworks, ECAN, ECONOMONITOR, 

FanSense, FlexROM, fuzzyLAB, In-Circuit Serial 

Programming, ICSP, ICEPIC, Linear Active Thermistor, 

MPASM, MPLIB, MPLINK, MPSIM, PICkit, PICDEM, 

PICDEM.net, PICLAB, PICtail, PowerCal, PowerInfo, 

PowerMate, PowerTool, rfLAB, rfPICDEM, Select Mode, 

Smart Serial, SmartTel, Total Endurance and WiperLock are 

trademarks of Microchip Technology Incorporated in the 

U.S.A. and other countries.

SQTP is a service mark of Microchip Technology Incorporated 

in the U.S.A.

All other trademarks mentioned herein are property of their 

respective companies.

© 2005, Microchip Technology Incorporated, Printed in the 

U.S.A., All Rights Reserved.

 Printed on recycled paper.

Note the following details of the code protection feature on Microchip devices:

• Microchip products meet the specification contained in their particular Microchip Data Sheet.

• Microchip believes that its family of products is one of the most secure families of its kind on the market today, when used in the 

intended manner and under normal conditions.

• There are dishonest and possibly illegal methods used to breach the code protection feature. All of these methods, to our 

knowledge, require using the Microchip products in a manner outside the operating specifications contained in Microchip’s Data 

Sheets. Most likely, the person doing so is engaged in theft of intellectual property.

• Microchip is willing to work with the customer who is concerned about the integrity of their code.

• Neither Microchip nor any other semiconductor manufacturer can guarantee the security of their code. Code protection does not 

mean that we are guaranteeing the product as “unbreakable.”

Code protection is constantly evolving. We at Microchip are committed to continuously improving the code protection features of our

products. Attempts to break Microchip’s code protection feature may be a violation of the Digital Millennium Copyright Act. If such acts

allow unauthorized access to your software or other copyrighted work, you may have a right to sue for relief under that Act.

Microchip received ISO/TS-16949:2002 quality system certification for 
its worldwide headquarters, design and wafer fabrication facilities in 
Chandler and Tempe, Arizona and Mountain View, California in 
October 2003. The Company’s quality system processes and 
procedures are for its PICmicro® 8-bit MCUs, KEELOQ® code hopping 
devices, Serial EEPROMs, microperipherals, nonvolatile memory and 
analog products. In addition, Microchip’s quality system for the design 
and manufacture of development systems is ISO 9001:2000 certified.



EXPLORER 16 DEVELOPMENT

BOARD USER’S GUIDE

© 2005 Microchip Technology Inc.   DS51589A-page iii

Table of Contents

Preface ........................................................................................................................... 1

Chapter 1. Introducing the Explorer 16 Development Board

1.1 Introduction ..................................................................................................... 7

1.2 Highlights ........................................................................................................ 7

1.3 What’s in the Kit ............................................................................................. 7

1.4 Explorer 16 Development Board Functionality and Features ......................... 8

1.5 Using the Explorer 16 Out of the Box ............................................................. 9

1.6 Explorer 16 Development Board Demonstration Programs ......................... 10

1.7 Reference Documents .................................................................................. 10

Chapter 2. Explorer 16 Programming Tutorial

2.1 Introduction ................................................................................................... 11

2.2 Highlights ...................................................................................................... 11

2.3 Tutorial Overview ......................................................................................... 11

2.4 Creating the Project ...................................................................................... 12

2.5 Building The Code ........................................................................................ 16

2.6 Programming the Device .............................................................................. 19

Chapter 3. Explorer 16 Tutorial Programs

3.1 Introduction ................................................................................................... 23

3.2 PIC24 Tutorial Program Operation ............................................................... 23

3.3 dsPIC33F Tutorial Program Operation ......................................................... 25

Chapter 4. Explorer 16 Development Hardware

4.1  Introduction .................................................................................................. 27

4.2 Hardware Features ....................................................................................... 27

Appendix A. Explorer 16 Development Board Schematics

A.1 Introduction .................................................................................................. 33

A.2 Development Board Block Diagram ............................................................. 33

A.3 Development Board Schematics .................................................................. 34

Appendix B. Updating the USB Connectivity Firmware

B.1 Introduction .................................................................................................. 43

B.2 Updating the PICkit 2 Microcontroller Programmer ..................................... 43

B.3 Other USB Firmware Updates ..................................................................... 44

Index ............................................................................................................................. 45

Worldwide Sales and Service .................................................................................... 46



Explorer 16 Development Board User’s Guide

DS51589A-page iv   © 2005 Microchip Technology Inc.

NOTES:



EXPLORER 16 DEVELOPMENT

BOARD USER’S GUIDE

© 2005 Microchip Technology Inc.   DS51589A-page 1

Preface

INTRODUCTION

This chapter contains general information that will be useful to know before using the 
Explorer 16 Development Board. Items discussed in this chapter include:

• Document Layout

• Conventions Used in this Guide

• Warranty Registration

• Recommended Reading

• The Microchip Web Site

• Development Systems Customer Change Notification Service

• Customer Support

• Document Revision History

DOCUMENT LAYOUT

This document describes how to use the Explorer 16 Development Board as a 
development tool to emulate and debug firmware on a target board. The manual layout 
is as follows:

• Chapter 1. “Introducing the Explorer 16 Development Board” provides a brief 
overview of the Explorer 16 Development Board, its features and its uses.

• Chapter 2. “Explorer 16 Programming Tutorial” provides step-by-step instructions 
for using MBLAB® IDE to create a project and program the Explorer 16 board.

• Chapter 3. “Explorer 16 Tutorial Programs” describes the demonstration 
program created in Chapter 2. “Explorer 16 Programming Tutorial”.

• Chapter 4. “Explorer 16 Development Hardware” provides a more detailed 
description of the Explorer 16 board’s hardware features.

• Appendix A. “Explorer 16 Development Board Schematics” provides a block 
diagram and detailed schematics of the Explorer 16 board. 

• Appendix B. “Updating the USB Connectivity Firmware” describes how to 
upgrade the Explorer 16 board’s USB connectivity subsystem.

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and 
documentation are constantly evolving to meet customer needs, so some actual dialogs 
and/or tool descriptions may differ from those in this document. Please refer to our web site 
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each 
page, in front of the page number. The numbering convention for the DS number is 
“DSXXXXXA”, where “XXXXX” is the document number and “A” is the revision level of the 
document.

For the most up-to-date information on development tools, see the MPLAB® IDE on-line help. 
Select the Help menu, and then Topics to open a list of available on-line help files.
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CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

WARRANTY REGISTRATION

Please complete the enclosed Warranty Registration Card and mail it promptly. 
Sending in the Warranty Registration Card entitles users to receive new product 
updates. Interim software releases are available at the Microchip web site.

DOCUMENTATION CONVENTIONS

Description Represents Examples

Arial font:

Italic characters Referenced books MPLAB® IDE User’s Guide

Emphasized text ...is the only compiler...

Initial caps A window the Output window

A dialog the Settings dialog

A menu selection select Enable Programmer

Quotes A field name in a window or 
dialog

“Save project before build”

Underlined, italic text with 
right angle bracket

A menu path File>Save

Bold characters A dialog button Click OK

A tab Click the Power tab

Text in angle brackets < > A key on the keyboard Press <Enter>, <F1>

Courier New font:

Plain Courier New Sample source code #define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static

Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants (in source code) 0xFF, ‘A’

Italic Courier New A variable argument file.o, where file can be 
any valid filename

Square brackets [ ] Optional arguments mcc18 [options] file 
[options]

Curly brackets and pipe 
character: { | }

Choice of mutually exclusive 
arguments; an OR selection

errorlevel {0|1}

Ellipses... Replaces repeated text var_name [, 
var_name...]

Represents code supplied by 
user

void main (void)
{ ...
}
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RECOMMENDED READING

This user’s guide describes how to use the Explorer 16 Development Board. Other 
useful documents are listed below. The following Microchip documents are available 
and recommended as supplemental reference resources.

Readme for the Explorer 16 Development Board

For the latest information on using the Explorer 16 Development Board, read the 
Readme for Explorer 16 Development Board.txt file (an ASCII text file) at 
the root level of the Explorer 16 CD-ROM. The Readme file contains update information 
and known issues that may not be included in this user’s guide.

Readme Files

For the latest information on using other tools, read the tool-specific Readme files in 
the Readmes subdirectory of the MPLAB IDE installation directory. The Readme files 
contain update information and known issues that may not be included in this user’s 
guide.

PIC24FJ128GA010 PS Data Sheet (DS39756) and PIC24FJ128GA Family 

Data Sheet (DS39747) 

Consult this document for detailed information on the PIC24F general purpose, 16-bit 
devices. Reference information found in this data sheet includes:

• Device memory map

• Device pinout and packaging details

• Device electrical specifications

• List of peripherals included on the device

Note that document, DS39756, is for use only with the initial prototype samples of the 
PIC24F family. These devices are all marked with a “PS” suffix at the end of the device 
number. For all other PIC24FJ128GA family devices, including those with an “ES” 
suffix, use DS39747.

dsPIC33F Family Data Sheet (DS70165)

Consult this document for detailed information on the dsPIC33F Digital Signal 
Controllers. Reference information found in this data sheet includes:

• Device memory map

• Device pinout and packaging details

• Device electrical specifications

• List of peripherals included on the device

dsPIC30F Programmer’s Reference Manual (DS70030)

This manual is a software developer’s reference for all of Microchip’s 16-bit digital 
signal controllers. It describes the instruction set in detail and also provides general 
information to assist in developing software for PIC24 MCUs, dsPIC30F and dsPIC33F 
DSCs.

PIC24H Family Overview (DS70166)

This document provides an overview of the functionality of the new PIC24H product 
family. It helps determine how the PIC24H high-performance, 16-bit microcontrollers fit 
a specific product application. 
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MPLAB® C30 C Compiler User’s Guide (DS51284)

This document details the use of Microchip’s MPLAB C30 C Compiler for dsPIC® 
devices to develop an application. MPLAB C30 is a GNU-based language tool, based 
on source code from the Free Software Foundation (FSF). For more information about 
the FSF, see www.fsf.org.

Other GNU language tools available from Microchip are:

• MPLAB ASM30 Assembler

• MPLAB LINK30 Linker

• MPLAB LIB30 Librarian/Archiver

MPLAB® IDE Simulator, Editor User’s Guide (DS51025)

Consult this document for more information pertaining to the installation and 
implementation of the MPLAB Integrated Development Environment (IDE) software. 

THE MICROCHIP WEB SITE

Microchip provides online support via our web site at www.microchip.com. This web 
site is used as a means to make files and information easily available to customers. 
Accessible by using your favorite Internet browser, the web site contains the following 
information:

• Product Support – Data sheets and errata, application notes and sample 
programs, design resources, user’s guides and hardware support documents, 
latest software releases and archived software

• General Technical Support – Frequently Asked Questions (FAQs), technical 
support requests, online discussion groups, Microchip consultant program 
member listing

• Business of Microchip – Product selector and ordering guides, latest Microchip 
press releases, listing of seminars and events, listings of Microchip sales offices, 
distributors and factory representatives
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DEVELOPMENT SYSTEMS CUSTOMER CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip 
products. Subscribers will receive e-mail notification whenever there are changes, 
updates, revisions or errata related to a specified product family or development tool of 
interest.

To register, access the Microchip web site at www.microchip.com, click on Customer 
Change Notification and follow the registration instructions.

The Development Systems product group categories are:

• Compilers – The latest information on Microchip C compilers and other language 
tools. These include the MPLAB C18 and MPLAB C30 C compilers; MPASM™ 
and MPLAB ASM30 assemblers; MPLINK™ and MPLAB LINK30 object linkers; 
and MPLIB™ and MPLAB LIB30 object librarians.

• Emulators – The latest information on Microchip in-circuit emulators.This 
includes the MPLAB ICE 2000 and MPLAB ICE 4000.

• In-Circuit Debuggers – The latest information on the Microchip in-circuit 
debugger, MPLAB ICD 2.

• MPLAB® IDE – The latest information on Microchip MPLAB IDE, the Windows® 
Integrated Development Environment for development systems tools. This list is 
focused on the MPLAB IDE, MPLAB SIM simulator, MPLAB IDE Project Manager 
and general editing and debugging features.

• Programmers – The latest information on Microchip programmers. These 
include the MPLAB PM3 and PRO MATE® II device programmers and the 
PICSTART® Plus and PICkit™ 1 development programmers.

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

• Distributor or Representative

• Local Sales Office

• Field Application Engineer (FAE)

• Technical Support

• Development Systems Information Line

Customers should contact their distributor, representative or field application engineer 
(FAE) for support. Local sales offices are also available to help customers. A listing of 
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support.microchip.com

DOCUMENT REVISION HISTORY 

Revision A (November 2005)

This is the initial release of this Document.



Preface

© 2005 Microchip Technology Inc.   DS51589A-page 6

NOTES:



EXPLORER 16 DEVELOPMENT

BOARD USER’S GUIDE

© 2005 Microchip Technology Inc.   DS51589A-page 7

Chapter 1.  Introducing the Explorer 16 Development Board

1.1 INTRODUCTION

Thank you for purchasing Microchip Technology’s Explorer 16 Development Board Kit. 
The development board provides a low-cost, modular development system for 
Microchip’s new line of 16-bit microcontroller families, including the PIC24, PIC24H and 
the 16-bit digital signal controller family, dsPIC33F. 

As provided, the development board works as a demo board right from the box, and 
also has the ability to extend its functionality through modular expansion interfaces. 
The Explorer 16 board supports MPLAB ICD 2 for full emulation and debug capabilities, 
and also allows 3V controllers to interface with 5V peripheral devices.

1.2 HIGHLIGHTS

This chapter covers the following topics:

• What’s in the Kit

• Explorer 16 Development Board Functionality and Features

• Using the Explorer 16 Out of the Box

• Explorer 16 Development Board Demonstration Programs

• Reference Documents

1.3 WHAT’S IN THE KIT

The Explorer 16 Development Board Kit contains the following:

• The Explorer 16 Development Board.

• A preprogrammed PIC24FJ128GA010 Processor Installation Module (PIM), 
already installed to the board 

• A preprogrammed dsPIC33FJ256GP710 PIM

• An RS-232 cable

• The Explorer 16 Development CD ROM, containing:

- This User’s Guide

- Data Sheets for the PIC24FJ128GA family and dsPIC33FJ256GP family

- Schematics and PCB drawing files for the PIM modules

- Example programs for use with the PIC24 and dsPIC33F devices

- Files detailing general purpose expansion boards that can be used with the 
Explorer 16 board (provided in Gerber format)

If you are missing any part of the kit, please contact your nearest Microchip sales office, 
listed on the last page of this manual, for further assistance.

Note: The Explorer 16 Development Board has been designed to function prima-
rily from a permanently mounted PIC24FJ128GA010 device at position U1. 
Initial units will be shipped with U1 unpopulated and a PIC24FJ PIM of 
equal functionality mounted on the U1A headers instead. When using the 
PIC24FJ PIM or any other PIM, it is critical to verify that switch S2 always 
remains in the “PIM” position. See Section 4.2.1 “Processor Support” for 
more information.
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1.4 EXPLORER 16 DEVELOPMENT BOARD FUNCTIONALITY AND FEATURES

A layout of the Explorer 16 Development Board is shown in Figure 1-1. The board 
includes these key features, as indicated in the diagram:

1. 100-pin PIM riser, compatible with the PIM versions of all Microchip 
PIC24F/24H/dsPIC33F devices 

2. Direct 9 VDC power input that provides +3.3V and +5V (regulated) to the entire 
board

3. Power indicator LED

4. RS-232 serial port and associated hardware

5. On-board analog thermal sensor

6. USB connectivity for communications and device programming/debugging

7. Standard 6-wire In-Circuit Debugger (ICD) connector for connections to an 
MPLAB ICD 2 programmer/debugger module

8. Hardware selection of PIM or soldered on-board microcontroller 
(in future versions)

9. 2-line by 16-character LCD

10. Provisioning on PCB for add on graphic LCD

11. Push button switches for device Reset and user-defined inputs

12. Potentiometer for analog input

13. Eight indicator LEDs

14. 74HCT4053 multiplexers for selectable crossover configuration on serial com-
munication lines

15. Serial EEPROM

16. Independent crystals for precision microcontroller clocking (8 MHz) and RTCC 
operation (32.768 kHz)

17. Prototype area for developing custom applications

18. Socket and edge connector for PICtail™ Plus card compatibility

19. Six-pin interface for PICkit 2 Programmer

20. JTAG connector pad for optional boundary scan functionality

For additional details on these features, refer to Chapter 4. “Explorer 16 Development 

Hardware”.

1.4.1 Sample Devices Included with the Development Kit

Each Explorer 16 Development Board Kit contains two preprogrammed 16-bit devices: 
a PIC24FJ128GA010 and a dsPIC33FJ256GP710. These are provided as 100-pin 
PIMs on riser sockets, which can be quickly installed on pin header U1A and 
exchanged as needed.

Note: As Microchip’s 16-bit portfolio develops, alternate devices may be included 
with the Explorer 16 Development Board Kit. It is anticipated that one 
device each of the PIC24 and dsPIC33F families will always be included. 
Also in the future, the included PIC24 device will be soldered onto the board 
and only the dsPIC33F device will be provided as a PIM.
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FIGURE 1-1: EXPLORER 16 DEVELOPMENT BOARD LAYOUT

1.5 USING THE EXPLORER 16 OUT OF THE BOX

Although intended as a development platform, the Explorer 16 board may also be used 
directly from the box as a demonstration board for PIC24 and dsPIC33F devices. The 
programs discussed in Chapter 3. “Explorer 16 Tutorial Programs” are 
preprogrammed into the sample device PIMs (i.e., PIC24ExplDemo.hex for the 
PIC24 device and dsPIC33ExplDemo.hex for the dsPIC33F device) and are ready 
for immediate use. 

To get started with the board:

1. For Explorer 16 boards without a permanently mounted PIC24FJ device: verify 
that the PIC24FJ128GA010 PIM is correctly installed onto the board. If you want 
to use the dsPIC® device PIM, carefully remove the PIC24 PIM and install the 
dsPIC33F PIM in its place. For all PIMs, be certain to align the PIM so the 
notched corner marking is oriented in the upper left corner.

2. For Explorer 16 boards without a permanently mounted PIC24FJ device: verify 
that switch S2 is set in the “PIM” position.
For Explorer 16 boards with a permanently mounted PIC24FJ device: verify that 
switch S2 is set in the “PIC” position.

3. Verify that the jumper on JP2 is installed (to enable the LEDs).

4. Apply power to the board (9 VDC) at power input J2. For information on accept-
able power sources, see Appendix A. “Explorer 16 Development Board 

Schematics”.

Refer to Chapter 3. “Explorer 16 Tutorial Programs” for details on the demonstration 
code operation.
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FIGURE 1-2: EXPLORER 16 PIM MODULE, SHOWING NOTCHED CORNER 

MARKING 

1.6 EXPLORER 16 DEVELOPMENT BOARD DEMONSTRATION PROGRAMS

The preprogrammed example code on the PIMs has been included on the Explorer 16 
CD-ROM for future reference. All project files have been included, so that the code may 
be used directly to restore a PIM to its original state (i.e., if the sample device has been 
reprogrammed with another program), or so the user may use the tutorial code as a 
platform for further experimentation.

In addition, the CD-ROM contains sample demonstration programs for both PIC24 and 
dsPIC33F family devices. Separate demo source code (as files in C) and compiled 
code files (in Hex) are provided for each family. These may be used with the included 
PIC24 and dsPIC33F PIMs by reprogramming the devices using MPLAB ICD 2.

1.7 REFERENCE DOCUMENTS

In addition to the documents listed in the “Recommended Reading” section, these 
documents are also available from Microchip to support the use of the Explorer 16 
Development Board:

• PIC18F2455/2550/4455/4550 Data Sheet (DS39632)

• TC1047/TC1047A Data Sheet (DS21498)

• 25AA256/25LC256 Data Sheet (DS21822)

• PICkit™ 2 Microcontroller Programmer User’s Guide (DS51553)

• MPLAB® ICD 2 In-Circuit Debugger Quick Start Guide (DS51268)

• PRO MATE® II User’s Guide (DS30082)

You can obtain these reference documents from your nearest Microchip sales office 
(listed in the back of this document) or by downloading them from the Microchip web 
site (www.microchip.com).

PIC24FJ128GA010
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Chapter 2.  Explorer 16 Programming Tutorial

2.1 INTRODUCTION

This chapter is a self-paced tutorial to get you started using the Explorer 16 Development 
Board.

2.2 HIGHLIGHTS

Items discussed in this chapter include:

• Tutorial Overview

• Creating the Project

• Building the Code

• Programming the Device

2.3 TUTORIAL OVERVIEW

The tutorial in this chapter demonstrates the main features of the MPLAB IDE and 
MPLAB ICD 2 as they are used with the Explorer 16 Development Board. As pre-
sented, it is designed for use with the PIC24FJ128GA010 specifically. However, the 
same procedures and toolsuites can also be used with PIC24H or dsPIC33F devices.

The PIC24 tutorial project demonstrated here, PIC24ExplDemo.mcp, is written in C 
for MPLAB C30. The program displays PIC24 features on the alphanumeric LCD, and 
also displays voltage, temperature and date/time as the various buttons are pressed. 
Described with the PIC24 project is the dsPIC device tutorial, 
Example1_RTC_LED_ADC.mcp. It is also written in C for MPLAB C30. The program 
displays voltage and current time, updating the display on command. Both programs 
are described in more detail in Chapter 3. “Explorer 16 Tutorial Programs”.

For either project, the source file (PIC24ExplDemo.c or main_rtc.c for PIC24 or 
dsPIC33F, respectively) is used with a linker script file (p24fj128ga010.gld or 
p33fj256gp710ps.gld) and header file (p24fj128ga010.h or 
p33fj256gp710ps.h) to form a complete project. While these simple projects use a 
single source code file, more complex projects might use multiple assembler and 
compiler source files, as well as library files and precompiled object files.

Upon completing this tutorial, you should be able to:

• Create a project using the Project Wizard

• Assemble and link the code and set the Configuration bits

• Set up MPLAB IDE to use the MPLAB ICD 2

• Program the chip with the MPLAB ICD 2

There are three steps to this tutorial:

1. Creating a project in MPLAB IDE.

2. Assembling and linking the code.

3. Programming the chip with the MPLAB ICD 2.
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2.4 CREATING THE PROJECT

The first step is to create a project and a workspace in MPLAB IDE. Typically, there is 
one project in one workspace.

A project contains the files needed to build an application (source code, linker script 
files, etc.) along with their associations to various build tools and build options.

A workspace contains one or more projects and information on the selected device, 
debug tool and/or programmer, open windows and their location and other MPLAB IDE 
configuration settings.

MPLAB IDE contains a Project Wizard to help create new projects. Before starting, 
create a folder named Tutorial for the project files for this tutorial (C:\Tutorial is 
assumed in the instructions that follow). From the Example Code\Tutorial Code 
directory on the Explorer 16 Development Kit Software CD-ROM, copy all of the source 
files into this folder. 

2.4.1 Select a Device

1. Start MPLAB IDE.

2. Close any workspace that might be open (File > Close Workspace).

3. From the Project menu, select Project Wizard.

4. From the Welcome screen, click Next > to display the Project Wizard Step One 
dialog (Figure 2-1). 

FIGURE 2-1: SELECTING THE DEVICE

5. From the Device drop-down list, select “PIC24FJ128GA010” or 
“dsPIC33FJ256GP710PS”, depending on the PIM being used. Click Next >. The 
Project Wizard Step Two dialog will be displayed (see Figure 2-2).

Note: These instructions presume the use of MPLAB IDE 7.22 or newer.

Note: The screen shots in the following sections show the PIC24 tutorial. Except for 
displayed file names, the screens for the dsPIC33F tutorial will be identical.



Explorer 16 Development Board User’s Guide

DS51589A-page 13   © 2005 Microchip Technology Inc.

FIGURE 2-2: SELECTING THE TOOLSUITE

2.4.2 Select Language Toolsuite

1. From the Active Toolsuite drop-down list, select Microchip C30 Toolsuite. This 
toolsuite includes the assembler and linker that will be used. 

2. In the Toolsuite Contents combo box, select MPLAB C30 Compiler 
(pic30-gcc.exe).

3. In the Location box, click Browse... and navigate to 
C:\Program Files\Microchip\MPLAB C30\bin\pic30-as.exe.

4. With MPLAB LINK 30 Object Linker (pic30-ld.exe) selected in Toolsuite 

Contents, click Browse... and navigate to
C:\Program Files\Microchip\MPLAB C30\bin\pic30-Id.exe.

5. Click Next > to continue. The Project Wizard Step Three dialog displays 
(Figure 2-3).
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FIGURE 2-3: NAMING YOUR PROJECT

2.4.3 Name Your Project

1. In the Project Name text box, type “MyProject”. 

2. In the Project Directory box, click Browse... and navigate to C:\Tutorial to 
place your project in the Tutorial folder.

3. Click Next > to continue. The Project Wizard Step Four dialog displays 
(Figure 2-4).

FIGURE 2-4: ADDING FILES TO THE PROJECT 
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2.4.4 Add Files to Project

1. From the list of folders on the PC, locate the C:\Tutorial folder. 

2. Select the source (.c) and header (.h) files. Click Add >> to include the file in 
the project.

3. Expand the C:\Program Files\Microchip\MPLAB 30\support\gld 
folder and select the p24fj128ga010.gld or p33fj256gp710ps.gld file, 
as appropriate.

4. Click Add >> to include this file in the project. There should now be two files in 
the project. 

5. Click Next > to continue.

6. When the summary screen displays, click Finish.

After the Project Wizard completes, the MPLAB Project window shows the source files 
in the Source Files folder and the appropriate linker script in the Linker Scripts folder 
(Figure 2-5).

FIGURE 2-5: PROJECT WINDOW

A project and workspace has now been created in MPLAB IDE. MyProject.mcw is 
the workspace file and MyProject.mcp is the project file. Double-click the 
PIC24ExplDemo.c file (for PIC24) or main_rtc.c file (for dsPIC33F) in the Project 
window to open the file. MPLAB IDE should now look similar to Figure 2-6.
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FIGURE 2-6: MPLAB® IDE WORKSPACE 

2.5 BUILDING THE CODE

In this project, building the code consists of compiling the source files to create an 
object file, MyProject.o, then linking the object file to create the MyProject.hex 
and MyProject.cof output files. (For dsPIC33F projects, the files would be 
Example1_RTC_LED_ADC.o, Example1_RTC_LED_ADC.hex and 
Example1_RTC_LED_ADC.cof.)The Hex file contains the data necessary to program 
the device, and the .cof file contains additional information that lets you debug the 
code at the source code level.

Before building, there are settings required to tell MPLAB IDE where to find the include 
files and to reserve space for the extra debug code when the MPLAB ICD 2 is used. 
For PIC24 projects, the following line in the system.h file is:

#include “p24fj128ga010.h”

For dsPIC33 projects, the line is:

#include “p33fj256gp710ps.h”

This line causes a standard include file to be used. Microchip provides these files with 
all the Special Function Register (SFR) labels already defined for convenience. 

To build the code, select Build Options > Project from the Project menu. The Build 
Options dialog displays (Figure 2-7). 

Project

Window

Output

Window

Source 

Window

Code
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FIGURE 2-7: BUILD OPTIONS 

2.5.1 Identify Assembler Include Path 

1. Select the General tab.

2. Click Suite Default. This tells the environment where to find the library files.

3. Select the MPLAB LINK30 tab to view the linker settings (Figure 2-8).

4. Check Link for ICD2.

5. Click OK. The text box closes while the linker reserves space for the debug code 
used by the MPLAB ICD 2.

6. Click OK again to save these changes. The project is now ready to build.
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FIGURE 2-8: MPLAB® LINK30 BUILD OPTIONS

2.5.2 Build the Project

From the menu bar of the main MPLAB IDE window, select Project > Make. The Build 
Output window displays (Figure 2-9).

Observe the progress of the build. When the “BUILD SUCCEEDED” message displays, 
you are ready to program the device.

FIGURE 2-9: BUILD OUTPUT
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2.6 PROGRAMMING THE DEVICE

The MPLAB ICD 2 In-Circuit Debugger is used to program and debug the 
microcontroller in-circuit on the Explorer 16 Development Board.

2.6.1 Set Up the Device Configuration

The device configuration for the target microcontroller can be set by two methods: 
using configuration macros in the source code, or using the Configuration Bits window 
in MPLAB IDE.

The PIC24 Explorer 16 tutorial code already includes configuration macros in the 
source code itself. It is only necessary to confirm that the following macros are in place 
near the top of the PIC24ExplDemo.c file:

_CONFIG1(JTAGEN_OFF & GSS0_OFF & GWRP_OFF & BKBUG_OFF & COE_OFF 

& FWDTEN_OFF & FNOSC_PRI) 

_CONFIG2(FCKSM_CSDCMD & OSCIOFNC_ON & POSCMOD_HS)

For the dsPIC33F tutorial code, confirm that the following macros are in place near the 
top of the main_rtc.c file:

_FGS(CODE_WRITE_PROT_OFF);

_FOSCSEL(FRC_PLL);

_FOSC(CSW_FSCM_OFF & OSC2_IO & XT);

_FWDT(WDT_OFF);

If configuration macros are not used in the source code, it is also possible to set device 
configuration with the Configuration Bits window. For the PIC24 code, the process is as 
follows:

1. From the main window’s menu bar, select Configure > Configuration Bits to 
display the configuration settings (Figure 2-10). 

2. Set the Configuration bits by clicking on a particular line item and selecting an 
option from the drop-down menu that appears. The Configuration bits should be 
set as shown in Figure 2-10. 

The settings that will most likely need to change are:

a) Primary Oscillator Select: HS Oscillator Enabled

b) Oscillator Select: Primary Oscillator (XT, HS, ES)

c) Clock Switching and Monitor: SW Disabled, Mon Disabled

d) Watchdog Timer Enable: Disable

Note: Before proceeding, make sure that the USB driver for the MPLAB ICD 2 has 
been installed on the PC (see the MPLAB® ICD 2 In-Circuit Debugger 
User’s Guide (DS51331) for more details regarding the installation of the 
MPLAB ICD 2). 
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FIGURE 2-10: CONFIGURATION SETTINGS (PIC24)

2.6.2 Connect and Enable MPLAB ICD 2

1. Connect the MPLAB ICD 2 module to the PC with the USB cable.

2. Connect the MPLAB ICD 2 to the Explorer 16 Development Board with the short 
RJ-11 cable. 

3. Apply power to the Explorer 16 board.

4. From the Debugger menu, click Select Tool > MPLAB ICD 2 to set the MPLAB 
ICD 2 as the debug tool in MPLAB IDE.

5. From the Debugger menu, select Connect to connect the debugger to the device. 
MPLAB IDE should report that it found the PIC24FJ128GA010 device, as shown 
in Figure 2-11.

FIGURE 2-11: ENABLING MPLAB® ICD 2 

Note: Do not use the Configuration Bits window to set device configuration if 
configuration macros are already used in the source code. In cases where 
both methods are used, configuration macros may override settings from 
the Configuration Bits window. Refer to the MPLAB IDE Simulator, Editor 
User’s Guide (DS51025) for additional information.

Note: MPLAB IDE may need to download new firmware if this is the first time the 
MPLAB ICD 2 is being used with a PIC24FJ device. Allow it to do so. If any 
errors are shown, double-click the error message to get more information.

Status indicates 
device is found
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2.6.3 Program the Device

1. From the Debugger menu, select Program to program the part. The Output 
window (Figure 2-12) displays the program steps as they occur. 

2. Observe the results of the programming. When “MPLAB ICD 2 Ready” displays, 
the device is programmed and ready to run.

FIGURE 2-12: PROGRAMMING THE DEVICE
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